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Foreword 
This manual primarily provides guidance on utilizing the KYIO-L Config software, 

which is designed for configuring the KYIO-L series I/O products. 
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Legal Notices 

Beijing Kyland Technology Co., Ltd. strongly advises you to read and fully 

comprehend the terms set forth in this legal notice before reading or using this 

document. Utilizing or reading this document constitutes acceptance of all the 

terms herein. 

1. Copyright: This document is copyrighted by Beijing Kyland Technology Co., 

Ltd. No entity or individual may reproduce, translate, or copy any portion of 

this document without prior written permission. Unauthorized distribution or 

commercial use is strictly prohibited. 

2. Updates and Modifications: The content herein is subject to change for 

reasons such as product upgrades or adjustments. Beijing Kyland Technology 

Co., Ltd. reserves the right to update this document without prior notice. Users 

are encouraged to regularly check for updated versions through authorized 

channels. 

3. Disclaimer: This document is intended solely for reference in using Beijing 

Kyland Technology Co., Ltd.'s products and services. While every effort is 

made to provide accurate and reliable guidance, no warranties, express or 

implied, are made with regard to the accuracy or reliability of the content. 

Beijing Kyland Technology Co., Ltd. shall not be held responsible for any 

errors or losses incurred by the use or reliance on this document. In no event 

shall Beijing Kyland Technology Co., Ltd. be liable for indirect, consequential, 

incidental, special, or punitive damages, including lost profits. 

4. Error Reporting: If you encounter any technical errors or typographical 

mistakes in this document, please contact Beijing Kyland Technology Co., Ltd. 

directly for rectification. 

5. Legal Actions: Infringements will be legally prosecuted. 

Copyright © 2022 Kyland Technology Co., Ltd. 
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Precautions 
1. Module Operations: All coupler modules support serial port functionality for 

uploading, downloading, and data monitoring. MODBUS TCP communication 

uniquely allows simultaneous uploading, downloading, and monitoring via 

both serial and network ports. Ensure that the MicroUSB data cable used is 

capable of both data transmission and power supply functionalities; certain 

mobile phone charging cables that only supply power are unsuitable for these 

operations. 

 

2. Digital Input Module (DI): The DI module introduces the concept of sub-

modules, commonly configured with multiple channels to handle digital 

Boolean signals. Sub-modules are dedicated to storing input count values and 

clearing count values for each channel. 

 

3. Power Module: A separate power module is unnecessary unless the 

aggregate power consumption of all I/O modules surpasses the output power 

capacity of the coupler module. In such instances, an additional power module 

becomes mandatory. 

 

4. Terminal Module: This module is essential for stabilizing the bus signal. 

 

5. Keyboard Shortcuts: 

n Ctrl+C: Copy I/O modules 

n Ctrl+V: Paste I/O modules 

n Delete: Remove I/O modules 

n Ctrl+S: Save configuration project 

n Ctrl+M: Export address table 

n F1: Access help documentation for viewing I/O technical parameters 
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1. Software installation 
Beijing Kyland Technology Co., Ltd. provides customers with KYIO-L Config V 

xxxx, a full-version installation file compatible with the .NET 4.0 environment. After 

receiving the software, double-click the installation icon and follow the sequence: 

"Install" > "OK" > "Next" > "Install". Optionally, you can create a desktop shortcut, 

and upon completion, a "KYIO-L Config" shortcut will appear on your desktop. 
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2. Interface introduction 

 

n Menu Bar: Main menu of KYIO-L Config software 

n Toolbar: Set of commonly used functions 

n Project Window: Hierarchical tree view of the active project 

n Properties Window: Displays particulars of the selected item. For example, 
for Coupler Modules it shows module name, number, description, device 
version, etc. 

n Main Window: 

u Basic Information: View module specifications like name, number, 
hardware and software versions, power consumption, and 
manufacturer. 

u Process Data: Utilized for online channel data monitoring 

u Parameter Configuration: Modifiable module parameters 

u Address Table: List of addresses occupied by the I/O module 

u Installation Information: Displays module details such as description, 
current consumption, size, remaining power, and product image. 

n Message Window: Outputs real-time logs covering operations like new 

project creation, uploading, downloading, and configuration modification. 
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2.1 Main menu 
◇ Documents 

Menu Submenu Description 
project New Construction Create new project 

 Open Project Open a saved project 
 Save all Save current project 
 Save as Save the current project as a new project 

quit  Close project 
 

◇ Tool 
Menu Description 

search device Pop up a new window for MODBUS communication search device 

Online upgrade A new window pops up for coupler module and IO module firmware 

upgrade 

 

◇ Options 
Menu Description 

Configuration Can modify software display language, software interface display 

color, device library description file path 

 

◇ Help 
Menu Description 
about You can view the information of Beijing Kyland Technology Co., Ltd. 

and the configuration software version number. 

exception help A new window pops up to remind you of abnormal exit. Please install 

Microsoft patches for versions below WIN7 sp1/XP. 
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2.2 Toolbar 
 
Menu general shortcut icons 

 
Icon Name Menu Description 

 new 
construction 

File-Project-New 
Project 

Create new project 

 Open project File-Project-Open 
Project 

Open a saved project 

 Save all File-Project-Save All Save current project 

 Save as File-Project-Save As Save the current project as a new 
project 

 Configuration Options-Configuration Can modify software display 
language, software interface 
display color, device library 

description file path 

 Search device Tools-Search 
Devices 

Pop up a new window for 
MODBUS communication search 

device 

 Firmware 
upgrade 

Tools-Online 
Upgrade 

A new window pops up for coupler 
module and IO module firmware 

upgrade 

 
about help-about You can view the information of 

Beijing Kyland Technology Co., 
Ltd. and the configuration software 

version number. 

 exception help help-exception help A new window pops up to remind 
you of abnormal exit. Please install 

Microsoft patches for versions 
below WIN7 sp1/XP. 

 
Coupler general shortcut icon 

 
Icon Name Menu Description 

 
module 

management 
Coupler-Module 

Management 
Add IO module 

 
online Coupler-Online Coupler module and IO module 

online monitoring 

 
Download IO 
parameters 

Coupler - Download IO 
parameters 

Download all parameters of the 
module 

 
Upload IO 
parameters 

Coupler-upload IO 
parameters 

Upload all parameters of the 
module 

 
delete coupler-remove Delete the current coupler 

module 

 
Rename Coupler - Rename Coupler module renamed 

 
copy Coupler-Copy Duplicate coupler and downlink 

IO module 
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Export address 

table 
coupler - export address 

table 
Export the address 

correspondence between the 
coupler module and the IO 

module 

 
Export 

document 
Coupler - export 
documentation 

Export all information of coupler 
modules and IO modules, 

including address tables, module 
parameters, dimension drawings, 

and module lists 

 

2.3 Project window 
Displays currently active projects in a tree format, 
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2.4 Properties window 
The Properties Window provides a detailed overview of the current item's 
parameters, which includes: 
 

n Coupler Module: Module name, module number, description, device 
version, total number of modules, interface options, device IP address, 
serial port number, and online refresh cycle. 

n IO Module: Module name, module number, description, and number of 
sub-modules. 
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2.5 Main window 
Basic Information: The Main Window displays essential details of the KYIO-L 

series IO module such as the module name, module number, hardware version, 

software version, description, current consumption, and device manufacturer. 

 
 

Process data: Display IO information for online monitoring of channel data 
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Configuration parameters: Display KYIO-L series IO module parameters, 

modifiable module parameters. 

Address Table: Displays the address mapping table for the selected KYIO-L 

series IO module. 
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Installation Information: Can display KYIO-L series IO module description, 

current consumption, module size, remaining current, product image. 

 

 

2.6 Message window 
The Message Window furnishes real-time operational logs and includes records of 

new project initiation, uploading, downloading, and modification of configuration 

parameters. It also displays any copy-paste operations carried out. 
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2.7 Shortcut keys 
 
Hot key Menu Describe 
F1  Enter the help document to view the 

remote IO hardware manual 
Ctrl+C engineering/coupler-

copy 
Copy project, KYIO-L series IO module 

Ctrl+V Engineering/Coupler-
Paste 

Paste project, KYIO-L series IO module 

Delete Project/Coupler-
Delete 

Delete project and KYIO-L series IO 
module 

Ctrl+S File-Project-Save All Save configuration project 
Ctrl+M Coupler-export 

address table 
Export KYIO-L series IO address table 
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3. Software operation 
3.1 Function introduction 

1. Selection 

2. Access Coupler Module (LC module) and IO Module (LS module) hardware 

manuals. 

3. Create, save, and open existing projects. 

4. Add KYIO-L series IO modules and view their parameters. 

5. Configure and modify KYIO-L series IO module parameters. 

6. Access the address mapping table and data addresses of LS modules. 

7. Conduct online tests on LS modules. 

8. Export data, including the KYIO-L series IO address table and engineering 

documentation. 

9. Execute firmware upgrades. 
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3.2 Communication interface 

 
Network Port: Communication via the network port is only possible when using the 

LC-1101 coupler module. Use it to search for the LC-1101 device, modify KYIO-L 

series IO module parameters, conduct online testing of LS module data, and 

perform firmware upgrades. 

 

Serial Port: For serial communication, a MicroUSB data cable with both data 

transmission and power supply capabilities is mandatory. Some mobile phone 

charging cables lack data transmission functionality and are therefore unsuitable 

for parameter uploads and downloads. After connection, the computer will 

automatically install the required drivers, and a port number will be displayed in the 

computer's device manager. 

Serial 
Port 

Network 
Port 
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3.3 Module selection 
Before selecting a module, you can press the F1 key to access the IO hardware 

manual. This enables users to make informed decisions about which modules to 

select. The KYIO-L Config software aids users in module selection and helps 

determine whether additional power modules are required. Power requirements 

can also be calculated based on the internal bus power current of the coupler 

module and the IO module's power consumption. 
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To start a new project, right-click 'Project > New Project' in the project directory, or 

use the shortcut or menu bar options. Manually enter the project name to proceed. 

 

 
To add a new coupler, right-click in the project directory and select 'New Coupler.' 

In the pop-up window, choose LC-1101 and select 'Serial Port' for the interface. 

Assign the serial port number as COM10 and click 'OK.' 
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To add IO modules to the LC-1101 coupler, right-click on LC-1101, choose 'Module 
Management,' and in the dialog box that appears, select the required IO modules. 
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The bottom-left corner displays the current consumption of the selected IO 
modules. If the available current is depleted, a warning in red font will appear, 
indicating the need for an additional power module
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In this example, the power module is prompted to be inserted into 10 slots. After 
adding the power module, you can continue to add other IO modules. 

 
 

In case a power module needs to be added, a dialog box will appear. Follow the 

instructions to place the power module in the specified slot. 

 

At this time, the power module LX-6108 must be inserted into the corresponding 

slot 10 , as shown below. During actual selection, the specific slot position for 

placing the power module shall be based on the red font prompts. If the power 

module added is after Slot 10, clicking "OK" will prompt a dialog box saying 

"Power consumption is too high, a power module needs to be added to Slot 10."  
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To continue configuring the IO module for the LC-1101 coupler, it's important to 

note that it can accommodate up to 32 modules, with the power modules 

occupying a specific number of slots. If you continue to add the IO module, the 

following window will pop up. 
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After adding the IO modules, clicking 'OK' will automatically populate them in the 

project panel. The Installation Information interface on the right will show the 

available current, and individual IO modules can be clicked to view their specific 

hardware information. On the right side of the installation information interface, you 

can see that the LC-1101 outputs a current of 2500mA, and a power module of 

2000mA has been added. After consuming power from 32 slots, the remaining total 

current is 975mA. Click on the icon of a single IO module to view the hardware 

information of the corresponding module. 



                                     KYIO-L Config Software Manual 
 

 

 26 

 

 

 

3.4 View and modify KYIO-L series IO configuration 
parameters 

 

Create a new project and add various Coupler and IO modules. Navigate to the 

Configuration Parameters section to view the default settings of the KYIO-L series 

IO modules. The parameters for the Coupler modules operating under Modbus 

TCP, Modbus RTU, and CANopen communication protocols require modification 

via the KYIO-L Config software, accessed through the third-party configuration 

interface. In contrast, Profinet, EtherCAT, and Profibus DP Coupler modules allow 

direct parameter modification in the third-party configuration interface without 

utilizing KYIO-L Config software. 
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The configuration parameters of the IO module can be modified in the KYIO-L 

Config software. After completing the modification of the IO module parameters, 

right-click on the coupler module and select "Download Configuration". 

 

Modbus TCP (LC-1101) configuration parameter interface: 

 
Modbus RTU (LC-2101) configuration parameter interface: 
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CANopen(LC-3101) configuration parameter interface: 

 
 

 

LD-1016 parameter interface 
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LD-2016 configuration parameter interface 

 
 

 

LA-1008 configuration parameter interface 
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LA-2004 configuration parameter interface 

 
 

LD-0008 configuration parameter interface 
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To modify IO module parameters, use the KYIO-L Config software. Once the 

modifications are complete, right-click on the Coupler module and choose the 

"Download Configuration" option. 
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After modifying all the parameters, select the coupler module and press the 

shortcut key "Ctrl+S" to save the entire configuration project file.

 

 

 

3.5 Online debugging KYIO-L series IO module 
Connect the system power supply and the field power supply to a 24Vdc power 

source separately. Establish a connection between the module and the computer 

using either a Micro USB or Ethernet cable. Note that the Micro USB connection 

requires driver installation. Upon successful installation, a COM port such as 

COM9 will be automatically assigned. 

 

1. Launch the installed KYIO-L Config software, navigate to File -> Project -> New 

Project in the menu bar, or right-click in the project directory and select Project 

-> New Project. Manually input the project name. 
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2. In the attribute panel, set the upload interface to Serial Port and select COM9 

for the serial port number. Right-click on the project name and select "Upload IO 

Module"; this will trigger an automatic scan of the IO module in the project column. 
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3. Right-click on the Coupler module LC-1101 and select the "Online" option to 

enable real-time monitoring of the IO module data. 
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Case 1: For LD-1308, supply its external DI0 with a 24VDC power source. The 

value CH0=1 can then be monitored in the process data interface.

 
 

Case 2: Assign a value of 30000 to CH0 in slot 4 of LA-2004, connecting it 

simultaneously to CH0 in slot 3 of LA-1008. Similarly, assign a value of 20000 to 

CH1 in slot 4 of LA-2004 and connect it to CH2 in slot 3 of LA-1008. 
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Note: For digital input modules, additional counting modules may be manually 

integrated.  
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Upon adding a sub-module, it is crucial to right-click and download the module 

configuration or IO parameters for LC-1101. Failing to do so and clicking "Online" 

will result in an error message: "The number of sub-modules does not match the 

total number of configured sub-modules." 

     

 

3.6 Search device (only for MODBUS TCP 

communication) 
When using the LC-1101 coupler module with MODBUS TCP communication, you 

can initiate a device search by clicking the search tool icon or utilizing the 

designated shortcut key. Upon activation, a pop-up interface will appear; select the 

local network card and initiate the search process. All available coupler modules 

within the network architecture will be automatically scanned and listed in the 

device inventory. This interface allows you to view various parameters such as 

hardware and software versions, IP addresses, etc. For networks with multiple 

couplers, the software also supports the "Blink" and "Download" functions for 

device searching and IP address modification, respectively, as well as a "Restart" 
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option. To upgrade firmware, select "Upgrade" to navigate to the dedicated 

upgrade interface. Click "Upload," and all IO modules within the project panel will 

be automatically uploaded.
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3.7 Update device library files (hardware support package) 

To integrate newly released IO modules, updating the device library file is essential. 

This can be done without requiring a software update. Firstly, copy and paste the 

most recent version of the GSDML-V2.33-Beijing Kyland Technology Co., Ltd.-

BLADEIO-A-20230627 device library file into the GSD directory of the software 

installation path. 

 

Subsequently, navigate to the menu bar and click on "Options" > "Configuration" or 

use the corresponding shortcut key. In the pop-up window, locate the newly added 

GSD library file under 'Gsd File' within the path configuration, and confirm by 

clicking "OK" to complete the device library update. 



                                     KYIO-L Config Software Manual 
 

 

 40 

 

 

3.8 Device firmware upgrade 
To initiate a firmware upgrade, open the KYIO-L Config software and select 

"Tools" > "Device Update" or use the designated shortcut key. A pop-up window 

will appear. Choose "Serial Port" as your communication interface (Ethernet can 

be selected for MODBUS TCP communication) and set the serial port number to 

"COM9". Click "Read Device Information" to view the current firmware version of 

the LC-1101 coupler module. 
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To specify the firmware file, click the corresponding area on the right side of the 

upgrade interface and select the upgrade file (.ofd) for the LC-1101 coupler module. 

Firmware details, including the upgraded version, can be viewed at the lower left 

corner of the upgrade interface.  

 

Should the firmware be up-to-date, no action is necessary. If not, select the Slot 

where the inconsistent module is located and click the checkmark (√) to initiate the 

upgrade. 
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Note: If the displayed hardware version in the lower left corner pertains to an IO 

module, mark the checkbox next to the corresponding module and click "Start 

Upgrade." 

     

During the upgrade process, click only on "Start Upgrade." Upon completion, if the 

system does not automatically switch to APP mode, you must manually click 

"Launch APP" or restart the device. 
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If the upgrade concerns only a single module, you may opt for automatic transition 

to the APP by selecting the corresponding option before clicking "Start Upgrade." 

The APP will launch automatically once the upgrade is finalized. For upgrading 

multiple modules, deselect the option for automatic transition to the app. Activate 

the APP manually after each module upgrade is completed. 
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3.9 Data export 
Select the coupler module and right click to export the address table, or click the 

shortcut icon  
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Select the coupler module and right click to export the document, or click the 

shortcut icon  
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3.10 EDS file export 
New project -> Add coupler module -> Select LC - 3101 -> Right click on coupler 

module -> Export EDS file New project -> Add coupler module -> Select LC-3101 

-> Right click on coupler module -> Export EDS file. 

 

 


